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About these instructions

1.2

1.3

1.4

About these instructions

The instructions describe the features and commissioning of the product and help you to oper-
ate the product as intended.

Read these instructions carefully before using the product. This is to avoid possible damage to
persons, property or the device. Retain the instructions for future use during the service life of
the product. If the product is passed on, pass on these instructions as well.

Target groups

These instructions are aimed at qualified personnel and must be carefully read by anyone
mounting, commissioning, operating, maintaining, dismantling or disposing of the device.

Explanation of symbols used

The following symbols are used in these instructions

DANGER
DANGER indicates an immediately dangerous situation, with high risk, the death or
severe injury, if not avoided.

>

WARNING
WARNING indicates a potentially dangerous situation with medium risk, the death or
severe injury, if not avoided.

>

ATTENTION
ATTENTION indicates a situation that may lead to property damage, if it is not avoided.

NOTE

In NOTES you find tips, recommendations and important information. The notes facili-
tate work, provide more information on specific actions and help to avoid overtime by
not following the correct procedure.

= =

» CALLTO ACTION
This symbol identifies steps that the user has to perform.

= RESULTS OF ACTION
This symbol identifies relevant results of steps.

Additional documents

The following additional documents are available online at www.turck.com:
Data sheets

Feedback about these instructions
We make every effort to ensure that these instructions are as informative and as clear as pos-

sible. If you have any suggestions for improving the design or if some information is missing in
the document, please send your suggestions to techdoc@turck.com.
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2 Notes on the product
2. Product identification
The following user manual describes common features and setup of the FEN20 product family:

IP address setup

EtherNet/IP configuration example
PROFINET configuration example
Modbus TCP configuration example

2.2 Turck service

Turck supports you with your projects, from initial analysis to the commissioning of your
application. The Turck product database under www.turck.com contains software tools for
programming,configuration or commissioning, data sheets and CAD files in numerous export
formats.

The contact details of Turck subsidiaries worldwide can be found on p. 41.

3 Foryour safety

The product is designed according to state-of-the-art technology. However, residual risks still
exist. Observe the following warnings and safety notices to prevent damage to persons and
property. Turck accepts no liability for damage caused by failure to observe these warning and
safety notices.

3.1 General safety instructions

The device must only be mounted, installed, operated and maintained by trained and quali-
fied personnel.

The device may only be used in accordance with applicable national and international regula-
tions, standards and laws.

The device meets the EMC requirements for industrial areas. When used in residential areas,
take measures to avoid radio interference.

V02.00 | 2022/04 5
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FEN20 product family

4 FEN20 product family

The common features and operating procedures, which are described in this guide, may be ap-
plied to every FEN20 device, see the following table and "Definition of terms".

Article IP  Input description Output description EtherNet/IP Advanced
features

5 T § 2
o g oz 2 % 2
5 ° & a 9 <
E - I ER
9 5 2 g & T 5 2 & g 3 8 %
8 3522 T35 2 g T iz
352288 £535 28§ $:5388¢s &
FEN20-4DIP-4DXP S 8 - DI PNP v 8 DO PNP 05A - 2 vV v vV / / v
FEN20-4DIP-4DXP-DIN S 8 v DI PNP - 8 DO PNP 05A v 2 Vv Vv V V V v
FEN20-4DIN-4DXN S 8 - DI NPN v 8 DO NPN O5A v 2 Vv Vv Vv Vv V/ v
FEN20-4DIN-4DXN-DIN S 8 v DI NPN v 8 DO NPN 05A v 2 o v v v/ v
FEN20-EN1 s 8 - R PNP - - - - - v 2 v v vV /- -
FEN20-EN1-DIN S 8 v R PNP - - - - - v 2 v v v Vv - -
FEN20-16DXP SH 16 - DI PNP - 16 DO PNP O5A v 2 v Vv V V V* VR
FEN20-4I10L S 4 v/ IOL PNP v 4 IOL PNP 04A 2 vV /v VvV /S -
* only BEEP-slave
** up to ARGEE3
Definition of terms
Address setup
S Software setup
SH Software and hardware setup via rotary switches
1/0 type
DI Discrete input
DO Discrete output
R Router function
Al Analog input
AO Analog output
IOL 10-Link Master or DI/DO
Signal type
PNP Sourcing
NPN Sinking
EtherNet/IP
Configuration Assembly Enables passing configuration data during ForwardOpen
DLR Device Level Ring
QC QuickConnect
ADC Address Conflict Detection
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Extended functions

FLC

Field Logic Controller

FEN20 can be converted into a simple Field Logic Controller (i.e. PLC) that
can execute a stand-alone application or become a distributed control
component of the EtherNet/IP, Modbus TCP or PROFINET based control
system. FLC solutions by Turck are made possible using ARGEE (A Really
Great Engineering Environment), a web-based programming environ-
ment that allows users to set conditions and actions directly at the field
level. By utilizing HTML5, Turck provides a complete engineering envi-
ronment for users to write, run, simulate, debug, and monitor code, all
without requiring the use of a PLC.

BEEP

Backplane Ethernet Extension Protocol

BEEP is a technology feature of many Turck Multiprotocol digital block I/0
modules. BEEP allows a network of up to 33 devices (1 master + 32
slaves) or 480 bytes of data, to appear to the PLC as a single device
on a single connection using a single IP address of the master.

NOTE

BEEP is supported by the following FEN20 devices that have firmware revision:
V3.3.4.0 FEN20-4DIP-4DXP, FEN20-4DIN-4DXN
V3.8.3.0 FEN20-16DXP (BEEP slave only)
not supported FEN20-EN1, FEN20-EN1-DIN, FEN20-4I0L

Refer to “ARGEE Reference Manual” for further information on FLC.
Refer to “BEEP Reference Manual” for further information on BEEP.




FEN20 IP address setup

5 FEN20 IP address setup

All FEN20 devices support software setup of the IP address using either Turck Service Tool or
BOOTP/DHCP server. Additionally, FEN20-16DXP has rotary switches capable of setting the IP
address. FEN20-4DIP-4DXP and FEN20-4DIN-4DXN stations do not have rotary switches capable
of setting the IP address.

5.1 Setting the IP address

Users should set the IP address using either Turck Service Tool or any other IP address server
such as BOOTP/DHCP utility, to set, modify or reset the IP address of the device.

The device out of box IP address setup is:
IP address: 192.168.1.254
Netmask: 255.255.255.0
Gateway: 0.0.0.0

Mode of operation:
PGM Programmable
DHCP Dynamic Host Configuration Protocol

NOTE

ﬂ In the PGM mode the device will reference the previous IP address at power-up, which
was assigned to the device prior to shut down.
» Use Turck Service Tool for the IP address management.

52  Downloading Turck Service Tool
The Turck Service Tool can be downloaded from the Turck Website using the following link:

Turck Service Tool
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5.3

Service tool features

The Service tool displays the assigned IP addresses of devices on the network:

Your Global Automation Partner

L 7 U B

[[] . EN .

@

Search.. (F5) | Change (F2) Wink (F3] Actions (F4) Clipboard Language Expert view ON

No. MAC address MName  IP address MNetmask Gateway Mode D
=1 00:07-45:25:B2:E9 192168144 2552552550 0000  PGM_DHCP FE
* 2 0007.46:26:17.BF 192.168.1.17 2552552550 0000 PGM_DHCP.A FE

|

L1

Found 2 Devices.

Overview of features

Function

Change (F2) Change device IP address when device is set to PGM or PGM_DHCP mode, or assign device a
PROFINET name

Wink (F3) Wink command - flashes BUS LED of the highlighted device

Actions (F4) Action button - used to reset the device to the factory default setting
Clipboard - copies selected connection
Language - Selects between English and German text
Expert View - Enables / disables advanced functions

Search (F5) Network Search function is used to discover Turck devices connected to the same physical
network segment

Start DHCP (F6) Starts the DHCP server

Configuration (F7) EtherNet/IP configuration page

ARGEE (F8) ARGEE handling

BEEP (F9) BEEP composite handling

V02.00 | 2022/04



FEN20 IP address setup

53.1  Assigning an IP address using Turck Service Tool

» Click F5 - Search network
» Highlight the device to be assigned/changed an IP address.

Your Global Automation Partner 'I'llllel(
. M.en . @ 3 er [&H .[X

Search... (F3) | Change (F2) Wink (F3) Actions (F4) Clipboard  Language Expert view ON | Start DHCP (F6) Configuration (F7)  ARGEE (F8) Close

No MAC address Name: IP address Netmask Gateway Mode Device Version  Adapter ARGEE Protocol

1 |ooo74e258289 | (o000 0.0.0.0 0000 [PGM DHCP [FEN204DIP4DXF  [3340 [1921681.50 DCP, Turck
=32 000746250875 1921681148 2552652550 0000  ROTARY FEN2O-16DXP 3830 192163150 suppoted  DCP, Turck

Found 2 Devices.

» Click F2 - Change.
» Enter the IP address, Netmask and Gateway addresses.

= Change device configurati... E@ﬂ

Device name:

IP corfiguration

MALC address IP address
00.07-46:25:B2.E9 152.168.1.44

Metmask: Gateway
255.255.255.0 0.0.0.0

[ Set IP configuration temporarity

Status messages:

» Complete setup by clicking button

» The Service tool immediately shows newly assigned IP address. The device Webserver may be
initiated by clicking on the IP address hyperlink if the address is on the same subnet as a PC
that runs the Service too.

NOTE
ﬂ 0.0.0.0 at IP address, Netmask and Gateway, indicates that the device came up with the
factory default setup and that DHCP client is active, requesting IP address assignment.

IP address Metmask Gateway
0.0.0.0 0.0.0.0 0000
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54  Assigning an IP address using Rockwell BOOTP/DHCP

» Search Rockwell Software directory for BOOTP/DHCP server tool:
. Rockwell Software 3

FactoryTalk Administration Conscle

W) Restart View Designer Services

&) studie 5000

. BOOTP-DHCP Tool
@ EOOTP-DHCP Tocl Help

5| BOOTP-DHCP Tool w

» Start DHCP tool and click on the MAC address of the device which needs and IP address

» Enter IP address and click OK.

K& BOOTP/DHCF Server 2.3 M= 3
File Tools Help
—Request History
Clear Higtory | Add to Relation List |
[hr:mirizec) | Type | Ethernet Address [MALC) | IF Address | Hogthame | ;I
9.22:48 DHCP  00:07:46:25:B2:E9 o
9.22:45 DHCP  00:07:4E:25:B2:E9
52244 DHCP  DDSOBEDS4008
9.22:43 DHCP  00:07-4E:25:B2:E9
92243 DHCF  00:1E:37-4E:82:F1 : T ———
52741 DHCP  Cosg76Fsegsl | EihemetAddess (MAC) |00:07:46:25:B2:E9
J2241 DHCR - O0:074E:25:B2E9 IPaddiess | 192 . 168 . 1 . 44 |
— Relation List Hastname: I —
New | Delete | Enatle BOOTF | Enatle DHE Dessiption: |
Ethemnet Address MAC] | Type | 1P Add K Cancel B

» The device is successfully assigned IP address when it appears in the IP Address column

R BODTP/DHCP Server 2.3
File Tools Help
— Request Histony
Clear History | Add to Felation List
[hr:mirzzec] | Type | Ethermet Address [MALC] | IP Address | Hogtname ;I
92417 DHCP 00:07:46:25:B2E9 192.168.1.44 oy
92417 DHCP 00:07:46:25:B2E9
92415 DHCP 0007 46:25:B2E9
92413 DHCP 0007 46:25:B2E9
92411 DHCP  00:07:46:25:B2ES
9:24:09 DHCP 44845644 6F A7
9:24:08 DHCP  00:07:46:25:B2ES LI
— Relation List
New | Delte | Ercble BIOTP | Ensbl=DHEF | Disablz BooTR/DHER |
Ethernet Addreszs [MAC] | Type | IP Address | Hoztname I Dezcription |
00:07.46:25:B2.E9 DHCP 192168.1.44
V02.00 | 2022/04 11



FEN20 IP address setup

55 FEN20-16DXP

» Three rotary switches of the FEN20-16DXP provide various modes of operation, as seen

below.
000: 192.168.1.254
9 0 4 g 0 4 9 0 1 1 - 254: static rotary
8 2 8 2 8 2 300: BootP
7 3 7 3 400: DHCP
85 4 65 4 65 4 500: PGM
600: PGM-DHCP
* 100 x 10 x 1 700: PROFINET

55.1  Modes of operation

Based on the position of the switches, the device performs the following operation:

000 Restore IP address

300 BOOTP mode client

400 DHCP mode client

500 PGM programmable mode

600 PGM-DHCP mode

700 PROFINET mode

900 Device Recovery Mode (F_reset)

1...254 Static IP address

NOTE
ﬂ The general rule of handling rotary switches when selecting mode of operation is:
Set the rotary switches to the desired position
Cycle power to the station.
Proceed with intended operation as explained hereafter.

Restore IP address mode (000)

The Restore IP address mode (Network Reset) restores the IP address to the default value. The
settings become effective after voltage reset.
When switches are set at 000, the device is capable to:
Respond to PING command,
Respond to Turck Service tool
Run device Webserver
» The device cannot be connected to a PLC and it does not respond to any connection request.

Default IP Address
The factory default setup when switches are set to 000 position:

IP address 192.168.1.254
Subnet 255.255.255.0
Gateway 0.0.0.0

NOTE
ﬂ Switch setting "000” is not an operating mode. After resetting the IP address to the
default values, it is necessary to set another mode.
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BOOTP/DHCP mode (300/400)

This mode assigns an IP address using the BOOTP/DHCP server respectively.

35 BOOTP/DHCP Server 2.3 o x|
Fle Tooks Help

Request Histon
Cleax History | Add to Flelation List |

[heminses) | Type | Ethemet Address [MAC) | P Addiess [ Host
1600012 DHCP  O0:17-08:61-4410

160007 DHCP  00:07-46:FF-20:07 192.168.1.125
16:00:07 DHCP  00:07-46.FF-20.07

New Entry il

v Ethemet Address (MACE  [00:07:46:FF:20:07
New || Delete || EnsbleBOnTF IP Address: .168 . 1
Ethemet Addiess (MAC) T Hostname: |

. E—
0007 45 FF-20:07 o Descaipion: ,—'Erla the TP address For the device to b

ok | cancal |

. 125

Status

Erittizs
Unable to servica DHCP request from 00:17:08:61:44:10. 1 of 256 |

> After an IP address is assigned, it is temporarily stored in the device. In order to permanently
store the IP address, set the rotary switches to either:

001...253 which affects the last octet of the device IP address
500 programmable position
» Then cycle power to the device.

PGM mode (500)
» Launch the Turck Service Tool

» Select F5 - search network
» Under Mode verify the device reads PGM

; Your Global Automation Partner 'I'“llel(

&t . [0.en. @ X

Search... (F5) | Change (F2) Wink (F3]) Actions (F4)

Clipboard  Language Expert view OFF | Close
Mo. MAC address M. IP address MNetmask Gateway Mode Device Version  Adapter
=1 00:07:46:25:0E:75 192.168.1.1 255.256.25... 0.0.0.0

PGM FEN20-16DXF  3.830 192168.1.50

» Select F2 - Change and change IP address
» Enter desired value.

» Click Setin device.

V02.00 | 2022/04 13



FEN20 IP address setup

PGM-DHCP mode (600)

PGM-DHCP mode is a combination of the DHCP (400) and PGM (500) modes.

The device, when initially powered with switches set to 600, acts as DHCP client. It requests
assignment of an IP address. After the IP address is assigned, the device disables DHCP and
switches to PGM mode. Switches may be left in 600 position.

Upon power cycle, the device retains the last known IP address.

» To reset PGM-DHCP mode, set rotary switches to 000 and cycle power

PROFINET mode (700)

Allows a PROFINET server to assign a PROFINET name and IP address to the device. The Turck
service tool may be used to assign device name and IP address.

RECOVERY mode F_Reset (900)

When the rotary switches are set to the RECOVERY mode (900), the device resets all device
resources to factory default values, including configuration parameters and IP address.

» Set rotary switches to 900, cycle the power and wait 10 seconds

» Set rotary switches to any other position and then cycle power.

NOTE
ﬂ Switch setting "000” is not an operating mode. After resetting the IP address to the
default values, it is necessary to set another mode.
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6 EtherNet/IP configuration (Rockwell)

It is assumed that there is working knowledge of RS Logix Desinger from Rockwell.

The FEN20 module (in this example the FEN20-4DIP-4DXP) is configured on the EtherNet/IP
network using either:

Generic device profile or

EDS file

The single generic device profile is available with the Logix5000 controllers. The collection of
the generic device profiles of the Turck devices is called a Turck Catalog File.

6.1 Turck catalog files

» Turck devices are assigned pre-defined configurations using the generic device profile. The
device configuration contains following information, as an example:

7| Module Properties Report: TBEN_S (ETHERNET-MODULE 1.1) [
General |Connedion | Module Infol
Type: ETHERMET-MODULE Generic Ethemet Module
Vendar: Allen-Bradley
Parent: TBEM_S
Name: TBEN_52 4A Connection Parameters
Assembly ]
Description: Ji Instance: Size:
Input: 103 7 = (16hit)
i Output: 104 T 2 (6bi)
C Format: | Data - INT =
omm Form =4 Configuration: 106 84 = [8bit)
Address / Host Name
IP Address:
@ Host Mame: al150

Status: Offline [ QK ]| Cancel | Aoph Help

» The collection of the predefined configurations is saved as an L5K file and called the catalog
file.

» There are several catalog files:
Turck_BLOCK_STATIONS contains all block block 10 station configurations
BL20-E Catalog file, contains all BL20 10 module and BL20-E-GW-EN configrations
BL67 Catalog file, contains all BL67 10 module and BL67-GW-EN configurations

NOTE
ﬂ Refer to document “How to Configure TBEN-Lx in RSLogix5000 Using Catalog File".

It contains detailed description of using the catalog files to configure TBEN-L, TBEN-S,
FEN20 and BLCEN.

V02.00 | 2022/04 15



EtherNet/IP configuration (Rockwell)

6.2  Configuration with catalog file
The FEN20 device configurations are located in the Turck_BLOCK_STATIONS catalog file.
6.2.1  FEN20 configuration procedure

» Open both your online project and the Turck_BLOCK_STATIONS_V24_FULL.ACD catalog file
in separate windows.

» Expand the 1756-EN2T FEN20 bridge in the catalog file.

» Drag the FEN20-4DIP-4DXP configuration and drop it into the Ethernet of the Controller
organizer.

» Drag the FEN20-16DXP configuration and drop it into the Ethernet .

» Close the catalog file.

File Edit View Search Logic Communications Tools Window Help

BodH & {BBR o 3 e s YR aa .
Offli . T RUN ]
Mo I;zes EID I~ oK l_qr_l 4 H i &= AF 4+ 4k Aur ALk

« » [\ Favorites 4 Add-Un_J4 GSafety & Alarms A Bit A

™ Energy Storage
2

Mo Edits 10

—_—m
@ Logix Designer - CLX72_v24 in TURCK_BLOCK_STATIONS_V24_FULLACD [175

Controller Organizer - 1;11 File Edit View Search Logic Cemmunications Tools Window Hely

[:I Controller CLX16v30 aEE & 4 2 oo 3 .

(23 Motion Groups Offline . T RUN [ B
[£ Add-On Instructions Mo Forces b 7 oK @ :
[3 Data Types No Edits a [T Energy Storage <« v

(3 Trends Redundancy (3] Path: Imone>

M., Logical Model
=& 1/0 Configuration Controller Organizer > X
v Pointl0 w

El-@5 Ethernet 2 |l &-Ev0 Configuration
=
o

s

- [@1769- B CLX16v30 - E31756 Backplane, 1756-A10

[ [0]1756-L72 CLXT2_v24 -

i S B [1]1756-EN2T FENZO
-2 Ethernet

~_ £l 1756-EN2T FEN20

\ % NETHERNET-MODULE FEN20_4DIP_4DXP
\\ ..... f) ETHERNET-MODULE FEN20_4DIN_4DXN

----- ﬂ ETHERMET-MODULE FEN20_16DXP

----- ﬂ ETHERMNET-MODULE FGEM_X5G16_5001
----- ﬂ ETHERMET-MODULE FGEM_IM16_5001
----- ﬂ ETHERMNET-MODULE FGEN_OM16_5001 =
----- ﬂ ETHERMET-MODULE FGEM_IOMEE_5001

----- ﬂ ETHERMET-MODULE FXEM_XSG16_0001_IP_C53000

----- ﬂ ETHERMET-MODULE FXEM_IM16_0001_IP_C530007

----- ﬂ ETHERMET-MODULE FXEM_OM16_0001_IP_CS3000

----- ﬂ ETHERMET-MODULE FXEM_IOMEE_0001_IP_CS300C
- 1 [2]1756-EN2T TBEN_L

-2 Ethernet

----- ﬂ 1756-EM2T TBEM_L

----- ﬂ ETHERMET-MODULE TEEM_L4_16DIP

m
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» Click on the dropped FEN20 device

» Insert the Name and IP Address into the following fields:

Controller Organizer

(23 Controller CLX16v30
(23 Tasks

(23 Motion Groups

(23 Add-On Instructions
(3 Data Types

23 Trends

Logical Model
=30 Configuration

abe ey

=5 Ethernet
:.-[B11769-L16ER-BE1E CLX16v30

f] ETHERNET-MODULE FEN20 4DIP_4DXP
... fl ETHERMET-MODULE FEN20_1G6DXP

> # X150 Module Properties Report: Local (ETHERMET-MODULE 1.001) ==
General” | Connection | Module Infa
Type: ETHERMNET-MODULE Generic Ethemet Module
Wendor: Allen-Bradley
Parent: Local
Mame: FENZ0_4DIP_4D¥%P Connection Parameters
Assembly .
Description: P Instance: Size
Input: 103 4 = (16bit)
T oup: 104 2 oebe)
Comm Fomat:| Data - INT
mm Fom : Corfiguration: 106 14 (8bit)
Address / Host Name
@ IP Address: 192 . 168 . 1 . 4
(71 Host Name: 2100
Status: Offline OK ] [ Cancel ] [ Apply ] [ Help ]

» Under Controller — Controller Tags, expand FEN20_4DIP_4DXP:C.Data tag
» The device configuration tag provides configuration options that may be selected / modified

at this point

Controller Organizer

3

-3 Controller CLX16v30
i ontroller Tag, i
(31 Controller Fault Handler
(23 Power-Up Handler
Tasks
(1 Metion Groups
[ Add-On Instructions
Data Types

abe pey

Logical Model
/0 Cenfiguration

[F11769-L16ER-BB1B CLX16v30
ETHERNET-MODULE FEN20_4DIP_4D}
... f]l ETHERNET-MODULE FEN20_16DXP

Scape: [BICLx16v30 ~  Show: All Tags - T
Name =g| e | Value # | For+ | Sty | Data Typ | Description
—| FEN20_4DIP_4DXPC Data {...1| .. |Hex |SINT400]

+ FEN20_4DIP_4DXP-C Datall] 16400 Hex |SINT Reserved

+ FEN20_4DIP_4DXP-C Data[1] 16400 Hex |SINT Reserved

+ FEN20_4DIP_4DXP-C Datal2] 16400 Hex |SINT Reserved

+ FEN20_4DIP_4DXP-C Datal3] 16400 Hex |SINT Reserved

+ FEN20_4DIP_4DXP-C Datald] 16400 Hex |SINT Reserved

+ FEN20_4DIP_4DXP-C Datal5] 16400 Hex |SINT Reserved

+ FEN20_4DIP_4DXP-C Datal6] 16400 Hex |SINT Reserved

+ FEN20_4DIP_4DXP-C Data[7] 16400 Hex |SINT Reserved

+ FEN20_4DIP_4DXP-C Datal8] 16400 Hex |SINT Reserved

— FEN20_4DIP_4DXP-C Datald] 16400 Hex |SINT Quick Connect, Bth Custom Setup
FENZ0_4DIP_4DXPC Data[9].0 a De...|BOOL Quick Connect: O=disable, 1=enable
FEN20_4DIP_4DXP C.Data[d] .1 a De..|BOOL Eth 1 Custom Setup: O=Autonegotiate, 1=100BT/FD
FEN20_4DIP_4DXP C Data[d] 2 a De..|BOOL Eth 2 Custom Setup: O=Autonegotiate, 1=100BT/FD
FEN20_4DIP_4DXP C Data[3] 3 0 De. |[BOOL  |Reserved
FEN20_4DIP_4DXP C Data[3] 4 0 De. |[BOOL  |Reserved
FEN20_4DIP_4DXP C Data[3] 5 0 De. |[BOOL  |Reserved
FEN20_4DIP_4DXP C Data[3] 6 0 De. |[BOOL  |Reserved
FEN20_4DIP_4DXP C Data[3].7 0 De. |[BOOL  |Reserved

—| FEN20_4DIP_4DXP-C Data[10] 16200 Hex |SINT  [Invert digtal input
FEN20_4DIP_4DXP C Data[l 0 De. |[BOOL | Digital In/Out 0- Invert digital input: D=no, 1=yes
FEN20_4DIP_4DXP C Data[l 0 De. |[BOOL | Digital In/Out 1 - Invert digital input: D=no, 1=yes
FEN20_4DIP_4DXP C Data[l 0 De. |[BOOL | Digital In/Out 2- Invert digital input: D=no, 1=yes
FEN20_4DIP_4DXP C Data[l 0 De. |[BOOL | Digital In/Out 3- Invert digital input: D=no, 1=yes
FEN20_4DIP_4DXP C Data[l 0 De. |[BOOL | Digital In 4 - Invert digital input: D=no, 1=yes
FEN20_4DIP_ADXP C Data[1 0 De. |[BOOL | Digital In 5 - Invert digital input: D=no, 1=yes
FEN20_4DIP_ADXP C Data[1 0 De. |[BOOL | Digital In 6 - Invert digital input: D=no, 1=yes
FEN20_4DIP_ADXP C Data[1 0 De. |[BOOL | Digital In 7 - Invert digital input: D=no, 1=yes

+-FEN20_ADIP_4DXP-C Data[11] 16200 Hex |SINT  |Digital In/Out O - Manual reset after overcurr., Digital In

+FEN20_ADIP_4DXP-C Data[12] 1630% Hex |SINT  |Digital In/Out O - Activate output, Digital In/Out 1 - Acti

NOTE

Turck catalog file advantages are:
The FEN20 configuration data is saved into the controller and downloaded to the
device whenever the connection between the PLC and the device is established.
The device replacement is seamless as configuration data is downloaded to new

device

The device configuration does not depend on the EDS file.
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6.3
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Configuration with EDS file

» The following example shows configuration an FEN20 device with a Rockwell PLC utilizing

the EDS file.

> Install EDS file using the Logix Designer menu.

6 Logix Designer - CLX16v30 in CLX16v30_FEN20_DuplexTest ACD [1769-L16ER-BB1BE 30.11]* - [Cont

A File Edit View Search Logic Communications Window Help

B & £+ BB o> 3

Options...

| Offline 0. ™ RUN
Mo Faorces F,:DK -
Energy Storage
No Edis 2| o

Security »

“ ' Documentation Languages...

=5 Controller CLX16v30

[y | I SR

> Select New Module in the Controller Organizer.

-5 1/0 Configuration

] Import »
| P Export »
Motion r

Select Module T

Catalog |Mil:ﬂsommy I Famim.l

Impeort Medule...

» Highlight device to add to the network and click Create.

FEN2D Clear Filters Hide Filters 2
Module Type Category Fiters - Module Type Vendor Fiters -
Analog |j'| Allen-Bradley |j'|
CIP Mation Converter Advanced Energy Industres, Inc.

Communication BALLUFF

Communications Adapter - Cognex Corporation -
4 m 3 ‘ m 3

» (Catalog Mumber Description
FEN20-16DXP
FEN20-4DIP-4DXP

Wender

TURCK
TURCK

Category
Communications Adapter

Communications Adapter

2 of 575 Module Types Found
Close on Create

(oo ] [ LClose | [ oo ]
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» Enter device Name and Ethernet Address fields.

e IS

General™ |Connection I Module Info | Intemet Protocal | FPort Conﬁgumtion|

Type: 6931090 FEN20-4DIP-4DXP
Vendor: TURCK
Parent: Local

Mame: FEN20 Ethemet Address

@ Pri . [
Description: FEND2DIPADHP @ Private Networlc: 152.168.1. '“IZI

() IP Address:

() Host Name:

Module Definition
Rewision: 2.005
Blectronic Keying: Compatible Module

Connections: Exclusive Owner

Status: Creating OK | | Cancel | [ Hebp

» Click Change to open the Module Definition.
» Select INT data format, click OK.

] Module Properties: Local (6931030 2.005) [==][==]

General |Connection I Module Info I Intemet Protocol I Port Configuration

Type: 6531090 FEN20-4DIP-4DXP
Vendor: TURCK
Parent: Local

MName: FEN20

>
[i7 Module Definition -

Revision: WEI

Electronic Keying: [Compatible Module v]

Description: FEN20-4DIP-40XP 4

Connections:

Module Definition Name Size

Input: 8 SINT
Rewision: 2.005 Exclusive Owner -

Output: 4

Blectronic Keying:  Compatible Madule

SINT
Connections: Exclusive Owner DINT
REAL

Status: Offline OK | [ Cancel ] ’ Help

V02.00 | 2022/04 19



EtherNet/IP configuration (Rockwell)

» Confirm and follow dialog to end configuration.

i ) Module Definition® - [ 2 ]—n|
Revigion: 005 (=
Blectronic Keying: [Compatible Module Y]
Connections: Eihemet Address
o pat @ Private Network: 1921681, #3
Exclusive O L ¢ INT
xclusive Owner = .
Output: 2 () IP Address:
() Host Name:
[ ok | [ cancel | [ Heb |
- A -
|

ogix Designer

1Y

Verify module properties before Applying changes.

Change module definition?

These changes will cause module data types and properties te change.
Data will be set to default values unless it can be recovered from the existing module properties,

[ Yes

J{

Mo ]

» The FEN20 data is represented in the INT data format:

* 0 X

Cpflsziions wisones Scope:  [BlcLd16v30 v Show: All Tags
E?: D e e e Mame -3|& |Value | For® | Style Data Type fDescription
S| =63 Tasks
% - £ Mation Groups +-FEN20.C {eeal] {-- _D030:69...
3 Add-On Instructions St foocl oo B
[ Data Types FEN20:1 ConnectionFautted 0 Decimal  (BOOL
23 Trends —-FEN20:1.Data {.=x1| [..|Decimal [INT[4]
Fh_" Logical Model +-FEN20:1.Data[0] 1] Decimal |INT
5] 1/0 Configuration +/-FEN20:1.Data[1] 1] Decimal  |[INT
+/-FEN20:1. Datal2] 1] Decimal |INT
= 3?5 Ethernet +-FEN20:|.Data[3] [u] Decimal  |[INT
—-FEN20:0 {---}] {- _D0D30:69...
—|-FEN20:0.Data Jewo}| {..|Decimal |INT[2]
+-FEN20:0 Data[0] 1} Decimal |[INT
+/-FEN20:0 Data[1] 1] Decimal  |INT

NOTE

Tag description is missing

Disadvantages of using EDS file for device configuration:

Minor changes to the EDS file requires the file to be updated. When done, a project
that had used previous release of the EDS file, cannot display device properties. This
is usually causing issues for a system integrator.
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7/ PROFINET configuration
7.1 GE Proficy machine edition setup

It is assumed that there is working knowledge of GE Proficy Machine Edition.
7.1.1  Create new GE project

» Create a New project in Proficy using New Project Wizard or Open Project.
» Select File > New Project.

"o Test - Proficy Machine Edition

File I Edit Search Project Target Variables Tools Window Help
(23 new Project... | ] N =W T

& Open Project...

e R A A2 L I

» For a new project, insert the Project Name, Project Template, and Project location.
» When done click OK.

Froject Mame; IF'LC'I

Praject Template: IEE Inteligent Platformms PACS pstems B3 j Set as default |
GE Inteligent Pl )
GE Inteligent Platiorms PACSpstemns R
GE Inteligent Flatforms Remate [/0 - PACSysters Fx3i Etherne
3 | GE Inteligent Platforms Remate 170 - Series 90-30 Ethernet
GE Inteligent Platiorms Remote [/0 - Series 90-70 Genius

Project Location:

GE Inteligent Platiorms Remote [/0 - Yerzakdax Ethernet -
GE Inteligent Platforms Rermate |/0 - Yerzakdax Genius i—
GE Intell GE Inteligent Platiorms Rermate [/0 - Yerzabdax Profibus
GE Inteligent Platiorms Senes 90 Micro PLC b
A& project wGE Intelligent Platforms Ser!es 90-20PLC i target
proJ GE Inteligent Platforms Seres 90-70 PLC e
preconfigur|ge Intelligent Platformns Versab ax Mano/Micro PLC
GE Inteligent Platiorms Verzabdas PLC
Guided Tour FCorvveyor Project hl
|
E|-- Sample Targetl: PACSysterns RX3I
E-f Target1 Data Watch Lists: Ernpty
Hardware Default PACSystermns
Eﬂﬁ Harf:lware Configuration Configuration: RK 3 |
ED Logic Logic Program  Contains ernpty
E‘%E Frogram Blocks Blocks: _MAIN LD Block
H o —D— —M'D'.IN Reference View Contains Default
g Reference 'u'lewl Tables Tables: Aire
% Supplemenital Files Supplemental Contains ermnpty
Files: folders
=l

ak. I Cancel
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PROFINET configuration

» Once the project is in Proficy, Right click on the Processor and select the CPU.
» Click OK.

File Edit Search Project Target “ariables Tools ‘Window Help
BEeEs v & B X @2 EE T 2
F #

Central Proceszing Unit |

]
.|
E--gﬂﬁ Hardware Configuration

=il Rack 0 {1cE9sCHS012)

- Slot 0 {ICE9SPSAN4D)

Slot 1 {Used With Slot 0 Cetaicy N”B' _ Cancel

] slot 2 (IC695CPLIZ1D) 05 F t CPL 5 MB w. Ethernet

1 Slot 3 (Used With Slat 2) ICEISCMUI PACSystems R3i MaxOn CPU
] St 4 ICEI5CRUST0 PACSystemns B3 CPU 10 MB
] Slts() ICEI5CPE310 PACSystems R<3i CPU 10 MB w/ Ethernet
] Slta () ICEIECPU31E PACSystems B3 1000MHz Celeron-t CPU 20 MB
o ST ICEI5CPU320 PACSystems Rx3i 1000MHz Celeron-t CPU B4 MB
o Setag ICE35CRU320 PACSysterrs: RX3i 1000MHz Celeron-t Redundancy CPU B4 MB
u Slat 9 () ICE9ECRUZ200P PALCSysterns =3 1000MHz Celeran-M Quad Redundancy CPU ...
@ sktton ICEIEMILIO01 PACSysterns B3 NIL
g slet11
g stz

aDpt... Uil EMa... Pm... |%Vari...

Ly

» To add the PROFINET Controller, right click on the slot the PROFINET card is in the chassis and
in the pop up window click Add Module.

=il Hardware Configuration ;I
=il Rack 0 (1C695CHS012)

----- By Slot 0 (ICE95PSAD4D)

----- Slat 1 (Used 'With Slat 0)

& @ Slat 2 (ICEOSCPEI0S)

..... st < ‘configure Enter

""" ' BT Chrl+

""" u Slutf Zopy (ZhplH-E

""" B st Gl |
----- g slot:

""" B slat<  add Madule. .. Ins

""" 0 slot: Replace Module,,,

""" B st pelete Madule el
----- g sl

(1 =A% | Anic Properties Alt+Enter _|;|
4 4

BBOpt. | Ui | EMa. EHPo.. [BVai. | 2 . |
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» In the Catalog Window, click on the Bus Controller Tab and select communication master. In
our example, the RX3i Profibus Master and RX3i PROFINET Controller are used.

» Click OK.

Catalog Mumber

| Description

catalog M

Central Proceszing Uit I
Dizcrete lnput I Dizcrete Output l Dizcrete Miked | Analog [nput I Analog Outpuk I
Analog Mi:-:edl Commurications  Bus Contraller Mu:utiu:unl 3rd F'art_l,ll F'u:uwerSuppIiesI

ICE93BEM 3
ICE93BERM 3N
ICEI3BEM 3N
ICES30 MM 200
ICE94BER 321
ICE94BER 3N
ICES4D Mk 200
ICEI5FPER 300
|ICEI5PHCOmM

90-30 Fanuc |/0 Link, Module [Master)
90-30 Geniuz Bus Contraller [GBC)
90-30 2.5 MHz FIF Buz Controller
A0-20 DeviceMet b azter
90-30 Fanuc |/0 Link, Module [Master)
F#3i Genius Buz Controller [GBEC]
=3 DeviceM et Master
R3i Profibus Magter

ROFIMET Contraller [2 SFF)

| Cancel |

7.1.2  Add the FEN20 device

V02.00 | 2022/04

» Right click on the PROFINET Controller in the Navigator Window. Select Launch Discovery
Tool in the Pop up Window.

n
Elﬁnﬁ Hardware Configuration *
=il Rack 0 (1CAI5CHS01Z *
----- By Slot O (ICEEEPSADEO)
----- Slak 1 {Used With Slok 0%
- @ Slot 2 (ICE95CPEANS)
[ Ethernet
- F S
#- B turck-fi Configure Enter
----- B slotai
_____ u Slat 5 () Zuk kel
_____ g slteq Copy Chrl4-C
_____ u Slat 7 ) Paste Zhrl
""" u Sl & () Add Module, ., Ins
""" @ slotsi) Replace Moduls, .
""" u Slot 106} Delete Module Del
----- O slar110
| —_ Add IO-Device. .. Ins J
PROpt. | o Ut | E2M  ChangeLa
Launch Discovery Toal i
checkor L
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PROFINET configuration

» Click on Refresh Device List to bring list of devices on the network.
» Select device to be modified and click edit device.

Connection Settings

Connection: ILDc:aI Area Connection 2 ;I
LAN: |Lan01 =]
Status: Mo Emors
Status | Device Mame s | IP Address | endor | Devic
L192168. 1. 2 Hanz Turck GrmbH + Ca. K&
2 fgen 192168, 1111 Hatz Turck GmbH + Co. KG FGEM
 Filters [343] Selection Properties

v Qﬁssigned MAC Address:  00-07-46-FF-40-CF IP &ddress: 192.168.1.2 |dentify Device |

Device Role:  Device Subnet Maszk: 255 255.2595.0 - -
W @yAssigned vith enors VendorD: 013D Gateway  192168.1.1 __EdiDevie |

¥ \:."JNol aszighed Device D 300

7.1.3  Assign FEN20 name and IP address

> In the properties window, the Device Name and IP address can be changed. You can also reset
the device to factory defaults and identify the device on the network. When identifying the
device, the LEDs on the gateway will flash. When Done click on the exit button.

FENZ0-16DXP Properties
Yendor Mame: Hans Turck GmbH + Co. KG Verdar ID: 0130
MAL Address: 00-07-48-FF-40-CF Device |D: 90071 Identify Device |
Device Type: FEMN20-1EDP Device Role: Device

i Device Mame

Ifen2[| Set Device Mame |

IP Address

|F Address: |'|92.158.1_2
Subnet Mask: |255.255.255.EI Set P Infarmation |
[EEICIRET I‘I 9216811

— Rezet device to factory zettings

Reset Device |

=

E xit |
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7.14  Installing GSD or GSDML files in the hardware configuration

» In the Toolchest window click on the dropdown arrow and select a Profibus or PROFINET
Device.

| (@ Profibus Devices j

— & All Drawers

- Proieci
“iEPLCt
=l Local

(@ 9030 Ethesnet NIU

— (@ Basic Data Types

— (2 Basic Enum Types

— (@ DeviceNet Devices

— (@ FBD Instructions

— ( Guided Tour

—& HART Utilities

— (@ LD Instructions

— (@ Motion Developer

ﬁ& Motion Developer Flowchart

—@ PACSystems ENIU High Availabily Enablers

— (@ PC FBD Instructions

— (@ PC Ladder Instiuctions

— @, PC SFC Instructions

i Profibus Devices

T% Profinet Devices
(22 DY Ctharmat M1

» Right mouse click the Toolchest window.
» Click Assistants > Add GSD File....

[ (@, Profibus Devices El

@ €1 GE INTELLIGENT PLATFORMS
£ HMS INDUSTRIAL NETWORKS AB
1-€) HORNER ELECTRIC

) TOTAL CONTROL PRODUCTS

1 TURCK INC_

£ WHEDCO, ING_

F

B-&8-3-8

®

Del

Export Drawer

Import Drawer

Import Drawer as Copy

Scan for-new cbjects

New Folder
Add GSD File. ..
Write To GSD File. ..
Update From GSD File...

NOTE

ﬂ All files with .GSD are the default GSD files in the English language. Other versions may
include GSE (English), GSF (French), and GSG (German) languages.
All PROFINET files are xml files.
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PROFINET configuration

» Browse to the folder where the GSD file is located.

» Select file(s). Click Open.

Choose a GSDML file to import
Look in: [ 5 FEN2D x| & @k E-

| GSDML-¥2, 2-TURCK-FENZ0-20130704-01 0600
| GSDML-Y¥2, 25-TURCK-FEMZ20-20130704-010600

File narme: I j Open I
Filez of type: IGSDML Files [GSDML" xml,GSDML" zip] j Cancel |
4

7.1.5  Adding a PROFINET device onto the network.

» Click on the PROFINET Devices drop down in the Toolchest.

Toolchest

i Profinet Devices j
[ &0l Drawers
—l—_ Praject

PLC1

=l Local
— I 3030 Ethernet NIU
—IE Basic Data Types
—If Basic Enum Types
I DeviceMet Devices
— (& FED Instructions
— & Guided Tour
— @ HART Utilities
— @ LD Instructions
— i Motion Developer
— i Motion Developer Flowchart
— i PACSystems ENIU High Availabily Enablers
—i PC FBD Instructions
I PC Ladder Instructions
I PC SFC Instructions

I Profibus Devices
. |—ga Prohinet Devices

'~ RX3I Ethernet NIU

—I%, YerzaSafe Integration

— i@ View [BuickPanel) Expert Dbjects
— i@ View [QuickPanel) 5cripting

— i View ActiveX objects

— i View Expert Objects

— i View Scripting
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» Click on the folder to open the folder
» Click on the GSDML file and drag it to the PROFINET card.

B x t

g Slot 0 (ICEI5P5A040)
Slat 1 {Used With Slot 03
- @ Slot 2 {ICE9SCPEIOS)
- B Shot 3 (ICESSPHCO01) *
- bl67 {#1) [BLET-GW-EN-PH] *
B- B turck-fen20-16dxp (#5) [FEN20-16D%F]
—- @l Slot O (FENZ0-16D3P) *
Lol Interface 1 (PN-IO) *
g Port 1(Port1)*
g Port z(Portz)*
@ slot 1(160x%P) *
B turck-fgen (#4) [FEEN-¥5G16-5001] *
- B slot 4 (ICEISPEM300) *
- [1]BLCDP *
@ [0]4a1vT*

LBl T1T4ATWT 1Y * h
«| | »

o [ ui. [EM. e 2 Int..

I (@ Profinet Devices

@1 GE Intelligent Pistforms

B3 Hans Turck GmbH + Co_KG

BB TURCHK

-l FGEN 2012061 2020107-w2_2-TURCK
= FoEn 201 20907010000-v2_2-TURCK
= FoEn 201208210201 07-v2_2-TURCK
=k FEN20 2013070401 0600-v2_2-TURCK

-y turck-fen20-ddip-dcxp (S SV 1_0_0_D Hv: HWW 1)
Ly turck-fen20-16eixp (S0 SW Y 1_0_0_0 HW Hw 1)

» Once it is under the PROFINET, click on the gateway and the device name and IP Address will

be in the Inspector. This must match the configuration downloaded to the gateway when us-

ing the network discovery tool.

----- fly Slot 0 (ICE95PSAC40])

----- Slot 1 {Used With Slok 0)

B~ @ Shot 2 {IC695CPEI0S)

B~ E| Slot 3 {ICE95PMNCO0LY *

B ble7 (#1) [BLET-Gw-EN-PH] *

- @l Slot O (FENZO-160HP) *
B Interface 1(PH-IC)*
g Port 1 (Pork 13*

g Port 2 (Port 2y

Bl Skt 1(160EF)*

- Shot 4 {1CE9SPEM30N) *
=i} [1]BLCDR *

[0] 4AI-vI *

M7 4aT-4T (17 *

8 turck-fen20-16dxp (#5) [FEN20-1608F]

B turck-Fgen (#4) [FGEN-%5G16-5001]*

10-Device
Device Number 5
Update Rate [miz) 128
Reference Varnable <Mohe:

ElMetwark [dentification

10 LA&N

Device Mame

Device Description

IF &ddresz 182.168.1.2

EGeneral
GSOML GSDMLAY22-TURCK-FEMN20-201 30704
Device Type FEMZ20-1EDF

Device Access Point IC| DAF 2
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PROFINET configuration

» Double click on turck-fen20-16dxp to bring up the properties and station parameters of the
gateway. Double click on slot 1 to bring parameters for the 16 DXP points.
7 x

----- fly Slot 0 (ICRISPSAD4D) |
----- Slot 1 (Used With Slaok 0)
- H Slot 2 (1C695CPE30S)
S~ @ St 3 (ICeEEPNCO01Y *
E- B bl67 (41 [BLET-GW-EN-PH] *
- B turck-fenz0-16dxp (#5) [FENZ0-1605P] ¢
{ E-H Slot O(FEMZO-16D%P) *
© o Hll Interface 1 (PRH-IC)*
-@l Port 1 (Port 1)*
o fl Port 2 (Porkz)*
© Lo Slob 1 (16DNRY*
- turck-fogen (#4) [FGEN-¥SG16-5001] *
@ st 4 (ICEESPEMA00T *
=i [1]BLCDR *
£ [0]saL-v*

- S CRPTARY FRRR: i
4| | >

Mo | i B BEr. [Bva. | D In. |

= This will bring up the GW parameters for PROFINET.

PROFIMET DCP - Direct Connection r (0.3.5.1) 160%P / (0.3.5.0) FEN20-16DXP ] F X
10-Device Access Paoint | tedia Redundancy  Station parameter | Protocol selection | GSDML Details I
Output behaviour at communication loss: ISet to zemo j
Dizable all diagnosis: r
Dizable output powver diagnosis: r
1/0 Azsistant Force Mode dizabled: r

» After changing the parameters click the x to close the window.

PROFINET DCP - Direct Connection / {0.3.5.1) 16DXP r (0.3.5.0) FEN20-16DXP I 5 X

Settings  |nputs/outputs I GSDML Datawlsl

Digital input 1:: INUlma\ j =
Digital input 2: Ianma\ j

Digital input 3 INolma\ j

Digital input 4:: INolma\ j

Digital input &:: INolma\ j

Digital input &:: INolma\ ﬂ

Digital input 7:: INolma\ j

Digital input &: INUlma\ j

Digital input 9: Ianma\ j

Digital input 10:: INolma\ j

Digital input 11:: INolma\ j

Digital input 12:: INolma\ j pu
Digital input 13 INolma\ ﬂ

Digital input 14:: INolma\ j

Digital input 15:: INUlma\ j

Digital input 16: Ianma\ j
Output 1:: IActivale j

Output 2:: IActivale j

Output 3: IActwale ﬂ
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8  Modbus TCP configuration

The Modbus TCP project and configuration of the FEN20 (in this example the FEN20-4DIP-4DXP)

V02.00 | 2022/04

is shown utilizing Turck’s TX500 HMI/PLC platform, which supports:
IEC 61131 multitasking PLC runtime utilizing CODESYS v3.5.8.1 PLC
20 MB program/data memory
32 kB non-volatile memory
PROFINET Controller (master)
EtherNet/IP Scanner (master)
Modbus TCP Client (master)
Modbus RTU Client (master)
CANopen Master (optional via plug-in module)
Modbus TCP Server (slave)
Modbus RTU Server (slave)
OPC UA Server
Standard Ethernet TCP/IP und UDP/IP communication
Serial RS232, R$485 and RS422 communication

Network topology used in the project:

Yeur Glabal Astomatian Patner '“m

Modbus TCP Master — TX500

192.168.1.48 192.168.1.145 182.168.1.44 192.188.1.54

192166148 Pregrarmming tael = C0S 38,51

192 1681,145 THE00=NMadbus TCP magter
192168144 FEN20-4DIP-40 %P~ Modbus TCP slave
152, 168.1.54 FEM20-18DXP - Modbus TCF slave
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Modbus TCP configuration

8.1

30

Create TX500 Modbus TCP master project

It is assumed that user has a basic knowledge of the CODESYS project and programming

environment.
» Open an existing project or start a new CDS3 project:

@ TX500 MOD_Master_rl.project - CODESYS

File Edit View Project Build Online Det

S & |

Devices + 0 X
=[5 TX500 MOD Master ri (=]
=N Device (TX507-P3CV01)
=&l PLC Logic

=i} Application
m Library Manager
PLC_PRG {FRG)
= @ Task Configuration
= -gE MainTask
& PLC_PRG

» At Tools menu, open Package Manager .

-

® TX500 MOD_Master_rl.project™ - CODESYS

File Edit Wew Project Build Online Debug

e E & #4

Tools | Window

Help

| f Package Manager...

m Library Repaositary. ..

» Verify that TX500 DTM package is installed; if not, follow dialog to install package.

o TX500_MOD_Master_rl.project™ - CODESYS

File Edit Wew Project Build Online Debug Tools

S E & YR =]

Window Help

(i} Package Manager

@ -

=l Currently installed packages:

Sort by: |Name

MName Version Installation date

= Blax-PG-EN-V3 1.0.5.0 6/23/2017
" TBEMLx-PLC-1x 1.0.3.0 6232017
T TX500 1.0.4.0 6232017

Update info

Licensze info
Mo license required
Mo license required

Mo license required

Hans Turck GmbH & Co. KG | T +49 208 4952-0 | F +49 208 4952-264 | more@turck.com | www.turck.com



8.1.1  Add Ethernet adapter

V02.00 | 2022/04

» Highlight Device in the Device organizer.
» Right-click to Add Device.

-~

® TX500_MOD_Master_rl.project” - CODESYS

File Edit \Wiew Project Build Online Debug Tools Win

BEE & v 4 Al =N

Dew:es > * X | B Devie

=[5 TX500_MOD_Master r1 (=] S
=B |Device (TX507-pp==s = !

=0 PLC Logic Cut
=} Applica
m Librz Paste N
PLC)
= @ Task

- &

oy %<

Copy ]

T

Delete
Properties... i

L
=[] Ethernet (Et
=- (i T}{EDD_h|
i FEn n

» Expand Fieldbuses in the Add device page.
» Expand Ethernet adapter and select Ethernet by Turck.

Add Object »
Add Falder. ..

U E @ X

Add Device...

® TX500_MOD_Master_rl.project - CODESYS

File Edit Wiew Project Build Online Debug Tools Window Help

Bzl & v d Ba @ X 4L IE -0 E 08 % |
Devices i
> X | [ Add Device
=[5 TX500_MOD Master_ri (=]
= .|Device (TX507-P3CV01) | Name: Ethernet
= PLC Leagi
E“] oo Action:
= a Application i ) )
m Library Manager @ Append device Insert device device @
PLC_PRG (PRG) Device:
B @ Task Configuration endor [qAII S
=& MairTask
@ PLC_PRG MName Werzion
+ m Miscellaneous
= [{J Fieldbusses
+.-CAN CANbus
~ - EHE Ethernet Adapter
[ @ ethemet 3.5.7.20

+- = EtherNet/IP
-0 Modbus

4 Profinet I0

31



32

» Click Add Device.

Name: Ethernet
Action:
@ Append device () Insert device () Plug device () Update device

F£I Miscellaneous
E-- Fieldbusses
r;---(nu CANbus

3.5.7.20

4. L EtharhatiTD

Device:
Vendor: | <all vendors: h
MName Vendor Version o

Group by category
Display all versions (for experts only)
Display outdated versions

Information:

Mame: Ethernet
Vendor: Turck

C i thernet

Version: 3.5.7.20

Order Number: -

, Ethernet Adapter, Ethernet Adapter

P

.

E

-

=

Append selected device as last child of
Device

&  (You can select another target node inthe navigator while this window is open.)

Add Device | | Close |

> At Ethernet Adapter, assign an IP address to the adapter (it is actual IP address of the TX500).

“® TX500_MOD_Master_rl.project* - CODESYS

-

File Edit Wiew Project Buld Online Debug Tools Window Help
B & o 4 B (MR -

[ CE ) g [E=2=-= 2 |2 |=

Ethernet X
Device (TX507-P3CV01) General
=B PLC Logic
H Qo Application Status
| ; .ﬂ Library Manager
PLC_PRG (PRG) Information

E--@ Task Configuration

_ =5 VanTask
8] pic PRe
|E|-- ] Ethernet Etheme) |

\

Interface: ULTIEMAC1 i Q |

@ Use Operating System Settings
() Change Operating System Settings

IP Address 192 . 168 . 1 . 145
St sk

Default Gateway [i]
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» Other option is to highlight Device, open Project menu, select Edit Object.

Add Object
Add Folder...

Scan For Devices...

=5 Templte TX. Update Device...
=B Dm:e(q“j" Edit Object |Cnr
E‘l] PLC ll it Mihicrt Witk i
> Scan network on the Scan network... page.
I Deviee x| .
Communication Settings Enehmrk_.. I%alzway ~ | Device ~
Applications
O™ Al |
Files —— H
L L -l
Log S — . .
Gatewawv "

» Confirm selection when right side is populated as follows:

-
Select Device

e,

/| Select the network path to the controller:

EI---%. Gateway-1(scanning...)

TX507-P3CV01

Sean network
Wink

0091

Target Version:
1.0.4.0

Target Vendor:
Turck

Target ID:
10CD 0203

Target Name:
Turck/ARM/WinCE TV

Target Type:
4096
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Modbus TCP configuration

8.1.2

34

Add Modbus master

» At Ethernet in the device organizer, right-click and select Add Device....

E Template TX500.project® - CODESYS
-

File Edit View Project Buid Online Debug Tools Window Help
BeEIE] | #d 5 IR -
EEre= B [ Add Device |
=5 Tempiate TXS00 [=]
=l Device (TX507-P3CV01) . ()
= B0 PLC Logic
= u Application CEITE
m Library Manager @ Append device () Insert device F e (7) Update device
PLC_PRG (PRG —
= Task Configuration
& g vendor: [<.nj| vendors > h
= @ MainTask
@ PLC_FRG ‘ Mame Vender Version
m Ethernet (Et m Fieldbusses
[ Properties...
+- = EtherNet/IP
Add Object +-WEs Modbus
) AddFolder... - H# Profinet 10
Add Device...
Insert Device...
Disable Device
Update Device...
[§" Edit Object
Edit Object With... B
Group by cateaory

» At Add device page, expand Modbus.

» Highlight Modbus TCP Master.

» Enter name TX500_Modbus_TCP_Master in the name field.
» Click Add Device at lower corner.

[ Add Device - — — oS

Mame: TX500_Modbus_TCP_Master

Action:

@ Append device () Insert device Flug device () Update device

Device:

Vendor: [cAH vendors: i
Name Vendor Version
= Fieldbusses

= = EtherNet/IP
=+ & EtherNet/IP Scanner

m EtherNet/IP Scanner 35 - Smart Software Solutions GmbH 3.57.0
=4 Modbus
=-wes Modbus TCPMaster
[ Modbus TcPMaster 35 - Smart Software Solutions GmbH ~ 3.5.8.10

=-wel ModbusTCP Slave Device
[ ModbusTCP Slave Device 35 - Smart Software Solutions GmbH ~ 3.5.5.0
+- B Profinet 10

Group by category
[] Display all versions (for experts only)
[] Display outdated versions

Information:

m MName: Modbus TCP Master
Vendor: 35 - Smart Software Solutions GmbH
Categories: Modbus TCP Master

Version: 3.5.8.10
Order Number: - <
Description: A device that works as a Modbus Master on Ethernet, = (]

Append selected device as last child of
Ethernet

&  (You can select another target node in the navigator while this window is open.)

[ Add Device ] [ Close
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> At TX500_Modbus_TCP_Master property page, check the check-box Auto-connect.

o TX500 MOD_Master_rl.project® - CODESYS

Eile Edit Wew Project Build Onlne Debug Tools Window Help

A - Fu e =
S=EEH & dh ) O | | &8 -
Devices -« 00X ’ Device ﬂ-i Ethernet ﬁi TX500_Modbus_TCP_
= _'|:| TXS00 MOD Masfer rl
=B Device (Tx507-P3CVOL) General Modbus-TCP
= Elﬂ PLC Logic ] Response Timeout (ms)1
= "J Application ModbusTCPMaster /O Mapping

1
m Library Manager Socket Timeout {ms)

ModbusTCPMaster Parameters
e 316 05
= @ Task Configuration
Status
) PLC_PRG

= [ IR ST RGN

Information

8.1.3  Add Modbus TCP slave

V02.00 | 2022/04

The next part shows how to configure FEN20-4DIP-4DXP as the Modbus TCP slave. The same
procedure is used for any other Modbus TCP slave device.

» At TX500_Modbus_TCP_Master, right-click and select Add Device....
» Select Modbus TCP Slave by 3S.

» Enter FEN20_4DIP_4DXP into Name field.

» Click Add Device and exit.

o vt von s et -coos Y

File Edit WView Project Build Onlne Debug Tools Window Help
BEEEI& =1 - [T L | 08 CF ) g S8 [ | =
) 5
[ Add Device ===
Devices * 3 X ]
= ) TXs00MOD_psster_r1 E] Name: FEN20_4DIP_4DXP|
=]l Device (TX507-P3CV01) Action:
=B PLC Logic @ Appenddevice () Insert device (7) Update device
=} Application
4 Device:
m Library Manager
PLC_PRG (PRG) Vendor: [<AII vendors > h
- l—;fk Configuration Name Vendor Version
- V”E"ﬂ—mk =-[ Fieldbusses
PLC_PRG = Wi Modbus
m Ethernet [Ethemet) =W Modbus TCP Slave
T¥500_Modbus_TCP_Maste:
m LI eI e [ m Modbus TCP Slave 35 - Smart Software Solutions GmbH 3.57.0
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Modbus TCP configuration

» At FEN20 in the device organizer, double-click to open the device property page.

- e —
@ Template TX500.project™ - CODESYS

Fie Edit Wew Project Build Online Debug Tools Window Help

S == | ¢4 05 IR - [ 18 | O xR e | =

De\j!ces +* 3 X m FEN20_4DIP_4DXP X
=5 Template TXS00 (=]
= l Device (TX507-P3CV01) General Modbus-TCP
=-E pLC Logic
=} Application Modbus Slave Channel Slave IP Address: 192 . 168 . 0 . 1
m Library Manager Unit-1D [1..247]

Modbus Slave Init

PLC_PRG (PRG)

= @ Task Configuration
ModbusTCPSlave Parameters
=& MainTask Port 502

] PLC_FRG

= m Ethernet (Ethernet)
=[] Tx500_Modbus_TCP_Master (Modbus TCP Me | | siatys
[ FEN20_4DIP_4DXP (Modbus TCP Slave)

Response Timeout (ms) 1000

ModbusTCPSlave /O Mapping

Information

» At General tab, enter the IP address of the FEN20-4DIP-4DXP into Slave IP address.
» Assign 1 to Unit-ID (each device has unique Unit-ID number).

B Devie ] Ethernet [ [fJ  TX500_Modbus_TCP_Master "] FEm20_aDIP_4DXP X
General Modbus-TCP
Modbus Slave Channel Slave IP Address: 192 . 168 . 1 . 4
Modbus Slave Init Unit-ID [1..247] 1

Response Timeout (ms) 1000
ModbusTCPSlave Parameters Port 02

ModbusTCPSlave IO Mapping

Status

Information

8.14  Configure FEN20 10 data map

» The FEN20-4DIP-4DXP data sheet contains the 10 data map of the device which is used to
configure 10 channels in the project:

Process Data Mapping
Modbus TCP Register Mapping
Reg Bit 15 | Bit14 | Bit13 | Bit12 | Bit11 | Bit 10| Bit9 | Bit8 | Bit7 | Bit6 | Bit5 | Bit4 | Bit3 | Bit2 | Bit1 | Bit0

Inputs (RO 0x0000 - - - - - - - - o7 Dig ois 14 D3 D2 D Do

Status (RO) 0x0001 - FCE - - CFG | COM |V1 low - - - - - - - - Diag
Wam

Diag (RO) Dx0002 - - - - - B B B R B B - - - - 15}
Diag

Outputs (RW) | Dx0300 - - - - - - - - - O3 | DO2 | DO1 | DOOD

/0 Diag (RO) | DxADDD - - - - SC03 | SCO2 | SCO1 | SCOo0 - - - - - - - IGS
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» At Modbus Slave Channel tab, click Add Channel.... button.

[ Ethernet (7] FEM20_4DIP_aDXP X <

General Mame  Access Type  Trigger  READ Offset Length Error Handling  WRITE Offset [
Modbus Slave Channel
Modbus Slave Init
ModbusTCPSlave Parameters
ModbusTCPSlave /0 Mapping

Status

Information 4 n | +

[ Add Channel... ] [ Delete... ] [ Edit...

» Configure Channel 0 input data block, starting at address 0x0000 and data size 3 where:
Address 0x0000 Input data
Address 0x0001 Device status
Address 0x0002 |0 Diagnostic warning bit

ModbusChannel Iﬁ

Channel

Name Channel 0

Access Type [F‘.ead Input Registers (Function Code 4) -
Trigger [Cydic vl Cycle Time {ms) 100
Comment

READ Register

Offset 00000 -
Length 3
Error Handling | Keep last Value -

WRITE Register
Offset

Length 1

0K ] [ Cancel

V02.00 | 2022/04 37



Modbus TCP configuration

» Configure Channel 1 output data block, starting at address 0x0800 and data size 1 where:

Address 0x0800 Output data
ModbusChannel ﬁ

Channel
Name Channel 1
Access Type [Write Multiple Registers (Function Cade 16) -
Trigger [Cydic vl Cycle Time {ms) 100
Comment Output data
READ Reqgister
Offset
Length 1
Error Handling | Keep last Value
WRITE Reqister
Offset 0x0800+ -
Lenath 1

OK ] [ Cancel

» Add next channel for the IO diagnostics. It is read-only at:
Address 0xA000 10 diagnostics
-
ModbusChannel ﬁ

Channel
Mame Channel 2
Access Type [Read Huolding Registers (Function Code 3) -
Trigger [Cydic = | Cycle Time (ms) 100
Comment Diag IO
READ Reqgister
Offset OxAD000 -
Length 1
Error Handling Keep last Value -
WRITE Register
Offset 0x0000
Length 1

0K l [ Cancel
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The 10 data map overview:

Name Access Type Trigger READ Offset Length  ErrorHandling  WRITE Offset Length  Comment
-~ Channel 0 Read Input Registers (Function Code 04) Cydlic, t#100ms 1630000 3 Keep last Value Input registers
Channel 1 Write Multiple Registers (Function Code 18) Cydic, t=100ms 1620000 1 Output data
‘- Channel 2 Read Holding Registers (Function Code 03] Cydic, t£100ms ~ 16#A000 1 Keep last Value Diag 10
» Select how are channels updated at Always update variables field as follows.
Always update variables: |Enabled 2 in bus -
s ﬁ Ethernet '] FEN20_4DIP_aDXP X | -
T Channels
Variable Channel Address Type Defa.. U Description
RorBE e o Channe 0 %IWS0  ARRAY [0..2] OF WORD Read Input Registers
- Channel 1 SLQWI50 ARRAY [0..0] OF WORD Write Multiple Registers
Modbus Slave Init . " X
ES ] Channel 2 SRIWS3 ARRAY [0..0] OF WORD Read Holding Registers
ModbusTCPSlave Parameters
ModbusTCPSlave If0 Mapping
Status Reset Mapping | Always updatevariables: |Use parent device setting
. Use parent device setting
Information IEC Objects Enabled 1 (use bus cyde task if not used in any tasl
Variable Mapping  Type Enabled 2 (a in bus oy k)
\ @ FEN20_4DIP_4DXP # ModbusTCPSlave

» Online menu, Login:

=5 TX500_MOD_Master 1
= Device (TX507-P3CV01)
=l PLC Logic

V02.00 | 2022/04

% Logn

o4 Logout Cirl+Fa

Create boot application
Download

Online Change

Snnirea Arwanlnad tn ramnected devices
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» The FEN20-4DIP-4DXP configuration is completed and the project is running.

Ny ®500 MOD

File Edit View Project Build Ornline Debug Tools Window Help
BEFE & v oo By (MR -

=5 TX500 MOD_Master_r1

- Bowelmesosreon)

=B PLC Logic

- O Apphcationfrun]

>.ﬂ Library Manager

= & MainTask
8] pLc PRG
=% (] Ethernet (Ethernet)
=73 [f] TY500_Modbus_TCP_Master (Madbus TCP Master)

----- “% 7 FEN20_4DIP_4D¥%P {(Modbus TCP Slave)

» Create Boot application and download to the device.

=5 7500 MOD Master r1 Download
E{;. Online Change
=Bl PLC Logic )
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Turck subsidiaries -

Germany

Australia

Belgium

Brazil

China

France

Great Britain

India

Italy

Japan

Canada

Korea

Malaysia

contact information

Hans Turck GmbH & Co. KG
Witzlebenstralle 7, 45472 Milheim an der Ruhr
www.turck.de

Turck Australia Pty Ltd
Building 4, 19-25 Duerdin Street, Notting Hill, 3168 Victoria
www.turck.com.au

TURCK MULTIPROX
Lion d'Orweg 12, B-9300 Aalst
www.multiprox.be

Turck do Brasil Automacéo Ltda.
Rua Anjo Custédio Nr. 42, Jardim Andlia Franco, CEP 03358-040 Sao Paulo
www.turck.com.br

Turck (Tianjin) Sensor Co. Ltd.

18,4th Xinghuazhi Road, Xiging Economic Development Area, 300381
Tianjin

www.turck.com.cn

TURCK BANNER S.A.S.

11 rue de Courtalin Bat C, Magny Le Hongre, F-77703 MARNE LA VALLEE
Cedex 4

www.turckbanner.fr

GroBbritannien TURCK BANNER LIMITED
Blenheim House, Hurricane Way, GB-SS11 8YT Wickford, Essex
www.turckbanner.co.uk

TURCK India Automation Pvt. Ltd.

401-403 Aurum Avenue, Survey. No 109 /4, Near Cummins Complex,
Baner-Balewadi Link Rd., 411045 Pune - Maharashtra
www.turck.co.in

TURCK BANNER S.R.L.
Via San Domenico 5, [T-20008 Bareggio (MI)
www.turckbanner.it

TURCK Japan Corporation
Syuuhou Bldg. 6F, 2-13-12, Kanda-Sudacho, Chiyoda-ku, 101-0041 Tokyo
www.turck.jp

Turck Canada Inc.
140 Duffield Drive, CDN-Markham, Ontario L6G 1B5
www.turck.ca

Turck Korea Co, Ltd.

B-509 Gwangmyeong Technopark, 60 Haan-ro, Gwangmyeong-si,
14322 Gyeonggi-Do

www.turck.kr

Turck Banner Malaysia Sdn Bhd

Unit A-23A-08, Tower A, Pinnacle Petaling Jaya, Jalan Utara C,
46200 Petaling Jaya Selangor

www.turckbanner.my
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https://www.turck.com.au/en/
https://www.multiprox.be/nl/
https://www.turck.com.br/pt/
http://www.turck.com.cn/
https://www.turckbanner.fr/fr/
https://www.turckbanner.co.uk/en/
http://www.turck.co.in/
https://www.turckbanner.it/it/
https://www.turck.jp/ja/
https://www.turck.ca/en/
https://www.turck.kr/ko/
https://www.turckbanner.my/en/

Mexico

Netherlands

Austria

Poland

Romania

Russian

Federation

Sweden

Singapore

South Africa

Czech Republic

Turkey

Hungary

USA

Turck subsidiaries - contact information

Turck Comercial, S. de RL de CV

Blvd. Campestre No. 100, Parque Industrial SERVER, C.P. 25350 Arteaga,
Coahuila

www.turck.com.mx

Turck B. V.
Ruiterlaan 7, NL-8019 BN Zwolle
www.turck.nl

Turck GmbH
Graumanngasse 7/A5-1, A-1150 Wien
www.turck.at

TURCK sp.z.o.0.
Wroclawska 115, PL-45-836 Opole
www.turck.pl

Turck Automation Romania SRL
Str. Siriului nr. 6-8, Sector 1, RO-014354 Bucuresti
www.turck.ro

TURCK RUS OO0
2-nd Pryadilnaya Street, 1, 105037 Moscow
www.turck.ru

Turck Sweden Office
Fabriksstraket 9, 433 76 Jonsered
www.turck.se

TURCK BANNER Singapore Pte. Ltd.

25 International Business Park, #04-75/77 (West Wing) German Centre,
609916 Singapore

www.turckbanner.sg

Turck Banner (Pty) Ltd
Boeing Road East, Bedfordview, ZA-2007 Johannesburg
www.turckbanner.co.za

TURCK s.r.o.
Na Brne 2065, CZ-500 06 Hradec Kralové
www.turck.cz

Turck Otomasyon Ticaret Limited Sirketi

Indnl mah. Kayisdagi c., Yesil Konak Evleri No: 178, A Blok D:4,
34755 Kadikdy/ Istanbul

www.turck.com.tr

TURCK Hungary kft.
Arpéd fejedelem utja 26-28., Obuda Gate, 2. em., H-1023 Budapest
www.turck.hu

Turck Inc.
3000 Campus Drive, USA-MN 55441 Minneapolis
www.turck.us
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28 subsidiaries and over
60 representations worldwide!
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